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Before you begin

Welcome to OrCAD
OrCAD offers a total solution for your core design tasks: 
schematic- and VHDL-based design entry; FPGA and 
CPLD design synthesis; digital, analog, and mixed-signal 
simulation; and printed circuit board layout. What’s more, 
OrCAD’s products are a suite of applications built around 
an engineer's design flow—not just a collection of 
independently developed point tools.
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How to use this guide
The OrCAD Layout Autoplacement User’s Guide contains 
information about working with autoplacement in 
OrCAD Layout Plus. This book only includes information 
that is specific to autoplacement. Information that is 
applicable to both manual placement and autoplacement 
is covered in the OrCAD Layout User’s Guide.

To help you learn and use autoplacement efficiently, this 
manual is separated into the following sections:

• Introducing autoplacement discusses three advanced 
features of autoplacement that greatly enhance 
component placement techniques.

• Using autoplacement discusses loading a placement 
strategy file and the procedures for placing 
components.

Symbols and conventions
OrCAD printed documentation uses a few special 
symbols and conventions.

Notation Examples Description
C+r Press C+r Means to hold down the C key while 

pressing r.

A, f, o From the File menu, choose Open (A, f, 
o)

Means that you have two options. You 
can use the mouse to choose the Open 
command from the File menu, or you 
can press each of the keys in 
parentheses in order: first A, then f, 
then o.

Monospace font In the Part Name text box, type PARAM. Text that you type is shown in 
monospace font. In the example, you 
type the characters P, A, R, A, and 
M. 
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UPPERCASE In Capture, open CLIPPERA.DSN. Path and filenames are shown in 
uppercase. In the example, you open 
the design file named CLIPPERA.DSN.

Italics In Capture, save design_name.DSN. Information that you are to provide is 
shown in italics. In the example, you 
save the design with a name of your 
choice, but it must have an extension of 
.DSN.
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Introducing autoplacement
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The underlying purpose of autoplacement in Layout Plus 
is to intelligently enhance component placement 
techniques. To accomplish this, Layout Plus offers three 
important and advanced features: push-and-shove 
placement, cluster placement, and precision placement 
algorithms.
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Push-and-shove placement
When you use the Shove command as you’re placing 
components, Layout Plus moves components in order to 
clear a spot for the component you’re placing.

Cluster placement
During autoplacement, Layout Plus automatically assigns 
each group (designated in the schematic design) to an 
appropriate cluster and places the components in 
proximity to one another on the board. As a result, the 
connections on a board are short, the placement has a flow 
to it, and the board is easier to work with.

Groups and clusters
Though they’re not essential to the process, groups and 
clusters play an important role in autoplacement. You can 
group components based on their functionality or 
connectivity in the schematic design, or in Layout Plus 
using the Components spreadsheet. You can also load a 
strategy file that assigns component groups to clusters 
and places the clusters on the board, taking into account 
preplaced clusters and components. However you 
implement them, you’ll find that the use of groups and 
clusters simplifies the placement process a great deal.



Precise placement algorithms

3

Precise placement algorithms
Layout Plus uses advanced algorithms to optimally 
situate components, even under severe design constraints. 
Because Layout Plus automatically uses these algorithms 
during component adjustment, proximity placement, and 
component swapping, it is able to consider hundreds of 
possible design permutations. As a result, component 
placement is enhanced for a wide variety of board types.
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Before you begin autoplacement, it is important to set up 
the board properly. Use the list below as a preplacement 
checklist, and ensure that these tasks are completed before 
you begin autoplacement.

n Check the board, place, and insertion outlines

n Check the place grid

n Check mirror layer or library layer settings

n Weight and color-code nets

n Check gate and pin data

n Check preplaced components and secure them on the 
board using the Lock or Fix commands

n Create component height keepins and keepouts, or 
group keepins and keepouts

Because these steps are the same for 
manual placement and autoplacement, 
they are described in Preparing the board 
for component placement in Chapter 7, 
Placing and editing components in the 
OrCAD Layout User’s Guide.
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Figure 1 A board prior to component placement.

Once you have set up a board, you can begin placing 
components. You can have Layout Plus autoplace the 
entire board for you, you can place components in groups 
(using clusters), or you can place components 
individually.

n Autoplacement allows for a wide range of board 
complexity. By having Layout Plus autoplace the 
entire board, you can leave considerations about 
density and design rules to Layout Plus. This 
component placement method is especially suited for 
situations that call for an analysis of all possible board 
configurations.

n Grouping components in clusters lends a logic and 
order to the design flow of your board. Grouping with 
clusters minimizes connection lengths and guarantees 
that similar components are grouped together.

n Layout Plus makes individual component placement 
easier with push-and-shove technology. Activating 
this technology (by choosing the Shove command) 
moves placed components out of your way, in order to 
make room for the component you’re trying to place.
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Placing components using 
autoplacement

Loading a placement strategy file
A placement strategy file determines the placement of 
components according to various parameters that you 
assign. For example, you can use a placement strategy file 
that includes the use of gate and pin swapping and 
component clusters. If you’re facing time constraints, you 
can limit the number of passes Layout Plus uses to analyze 
a given scenario, in order to expedite the placement 
process.

Using the Place Pass spreadsheet (choose the spreadsheet 
toolbar button, choose Strategy, then choose Place Pass), 
you can view the various parameters that govern the 
placement strategy file that is currently loaded. By 
changing the values of the parameters, you can create new 
strategy files (using an .SF extension) based on the existing 
strategy files.

To load a placement strategy file

1 From the File menu, choose Load. The Load File 
dialog box displays.

2 If necessary, change Files of type to Strategy.

3 Select a placement strategy file from the files listed, 
then choose the Open button. Placement strategy files 
begin with the letters “PL.”

The placement strategy files provided with Layout Plus 
are listed below. 

For information on editing placement 
strategies, see Editing place pass 
information on page 11.
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PLBEST.SF
Used for the best quality placement on most boards. The 
completion time of the placement process is generally 
longer than that of PLSTD.SF, especially with complex 
designs.

PLCLUST.SF
Automatically creates and places clustered components. 
This strategy file is helpful when you have no schematic to 
show relationships between components. In Layout Plus, 
clustered components appear as unfilled circles; the 
diameter of each circle is directly related to the area 
required by the components within the cluster.

PLFAST.SF
Quickly completes component placement for simple 
designs. This strategy may not result in the best 
component placement for complex boards with numerous 
buses. PLFAST.SF can be used to test for potential 
problem spots in larger placements, to evaluate the use of 
differently sized, equivalent components, or to determine 
which side of the board to use for the placement of 
surface-mount components.

PLFINISH.SF
Begins where PLCLUST.SF leaves off and finishes 
placement using PLBEST.SF.

PLSTD.SF
Used for standard component placement. PLSTD.SF is the 
best choice for most boards, though it takes substantially 
longer to complete the placement process than 
PLFAST.SF. This strategy does not include gate and pin 
swap.
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Disabling power and ground nets
During autoplacement, you are primarily concerned with 
connectivity between components. Because nets on plane 
layers are largely irrelevant to the placement process, you 
can disable these nets for routing. This also significantly 
improves system performance during placement, since 
disabled nets are not redrawn.

To disable nets attached to plane layers

n Choose the spreadsheet toolbar button, then choose 
Nets. The Nets spreadsheet displays.

n Using the CTRL key and the left mouse button, select all 
the cells in the Routing Enabled column that both 
pertain to nets attached to plane layers and read 
“Yes.” Release the CTRL key.

n From the pop-up menu, choose Enable<->Disable. 
The entries for the cells you selected change from 
“Yes” to “No,” indicating that the nets are disabled.

Autoplacing components
Once the board is set up properly and you have loaded a 
strategy file, you can choose the Board command to 
automatically place all of your components. When you 
choose this command, Layout Plus completes six passes of 
component placement. The progress of the operation 
displays in the status bar at the bottom of your screen.

To autoplace components

1 From the Auto menu, choose Place, then choose 
Board.

For information on setting net properties, 
see Chapter 4, Setting up the board in the 
OrCAD Layout User’s Guide.
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Pass 0
Performs an initial Proximity Place pass that clusters 
components based on interconnectivity and then places 
those clusters in locations that favor shorter connections. 
Pass 0 uses a minimal number of iterations (repeated 
algorithms) and attempts (different placements 
attempted).

Pass 1
Performs an Assign Clusters pass that takes all of the 
components that are not locked or fixed and puts them in 
clusters according to their interconnectivity and whether 
the components are grouped or not.

Pass 2
Performs a Place Clusters pass that places the clusters on 
the board based on connectivity and their position relative 
to other clusters or fixed components.

Pass 3
Performs a Proximity Place pass that uses a larger number 
of iterations and attempts than were used in Pass 0. This 
process places components more accurately.

Pass 4
Performs a Swap Comps pass that swaps neighboring 
components to see if placement can be improved by 
reducing connection length and crossovers.

Pass 5
Performs an Adjust Comps pass that adjusts the 
components in order to eliminate any overlapping.
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Note After you place the board, you can view component placement 
statistics using the Statistics spreadsheet. For information on 
viewing component placement statistics, see Viewing placement 
statistics in Chapter 7: Placing and editing components in the OrCAD 
Layout User’s Guide.

Editing place pass information
Layout Plus can also perform additional passes (Pass 6 
through Pass 11). Though these are disabled by default, 
you can enable them in the Place Pass spreadsheet. You 
can also alter the number of iterations and attempts 
performed by the six standard passes, as described above.

To edit place pass information

1 Choose the spreadsheet toolbar button, choose 
Strategy, then choose Place Pass. The Place Pass 
spreadsheet displays.

2 Double-click in the Pass cell that corresponds to the 
pass you want to modify. The Edit Place Pass dialog 
box displays.

3 Change the settings as desired, then choose the OK 
button.
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Figure 2 The Edit Place Pass dialog box

Enabled
Enable passes by selecting the Enabled option. Each pass 
displays either a Yes or a No in the Enabled column in the 
Place Pass spreadsheet, indicating that the Enabled option 
is either selected (Yes) or not selected (No) for the pass. If 
you decide that a pass is not necessary, you can deselect 
the Enabled option for the pass, in which case the 
autoplacement routine does not run the pass.

Done
A pass is automatically set to Done upon completion. This 
indicates which passes have been completed in the event 
that the autoplacement routine is interrupted. Once 
restarted, the autoplacement routine does not run any 
passes that are marked as Done.

Tip You can use the Done option to 
temporarily disable a pass, while leaving 
the underlying Enabled setting intact. This 
offers the advantage that you need only 
deselect the Done option, and everything 
will be returned to its previous state 
(either enabled or not enabled)
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Assign Clusters
Automatically groups components according to 
connectivity before they are placed on the board. Clusters 
maximize the number of connections between 
components within the same cluster, while minimizing 
the number of connections between clusters.

Proximity Place
Uses cluster locations as a starting point for board 
placement, then considers thousands of design 
permutations in order to choose a placement that 
optimizes quality.

Adjust Comps
After the clusters are broken, Layout Plus adjusts 
individual components in a rough grid pattern for a 
neater, more efficient placement.

Place Clusters
Places the assigned clusters in the best location on the 
board, relative to other clusters and fixed components.

Swap Comps
Swaps adjacent components in order to refine a nearly 
completed placement.

Swap Pins
Swaps pins using the package information from the 
schematic, to allow automatic pin swapping during 
autoplacement. This is not allowed if you created your 
board without a schematic.
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Fast Reconnect
Both the Proximity Place and the Swap Comps passes 
automatically use this option. You can disable this option 
to achieve a slightly better quality placement, but at lesser 
speed.

Swap Gates
Swaps gates in order to reduce the overall connection 
length on the board.

Iterations
Controls the number of algorithms Layout Plus employs 
during a given placement. The higher the number, the 
more algorithms Layout Plus uses. A low number results 
in a faster placement, but a decreased chance that Layout 
Plus will find the right placement for the board.

Attempts
Determines how many placements are attempted during 
each iteration. The higher the number, the more 
placement attempts are made, and the better the chance 
that Layout Plus finds the optimum placement for the 
board.

Max Clusters
Specifies the maximum number of clusters that Layout 
Plus uses during autoplacement. It is probably best to use 
the default set by your placement strategy file for 
maximum clusters. If you choose too high of a value, 
autoplacement spends a great deal of time forming the 
clusters.
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Using interactive placement 
commands
Layout Plus provides commands you can use to optimize 
placement. Using these commands, you can hide routes 
and connections, and shove, cluster, and adjust 
components to control exactly where they are placed on 
the board.

Hiding routes and connections
Reconnection mode prevents routes and connections from 
displaying on the screen, making it easier for you to see 
components and place them. With reconnection mode 
enabled, only nets connected to components you select are 
visible. As you move a component, its associated nets 
move with it, allowing you to account for connectivity 
while placing a component.

Tip If you are working with large nets, you can choose Minimize 
Connections from the pop-up menu while you’re moving a 
component. The shortest route for signals associated with the 
component is shown.

To hide routes and connections

1 Choose the reconnect toolbar button.

Or

1 From the Options menu, choose User Preferences. The 
User Preferences dialog box displays.

2 Select the Instantaneous Reconnection Mode option, 
then choose the OK button.

The reconnect toolbar button is “pushed in” and the 
phrase RECONNECT ON is added to the design 
window’s title bar.
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To re-display routes and connections

1 Choose the reconnect toolbar button.

Or

1 From the Options menu, choose User Preferences. The 
User Preferences dialog box displays.

2 Deselect the Instantaneous Reconnection Mode 
option, then choose the OK button.

The reconnect toolbar button is not “pushed in” and the 
phrase RECONNECT ON is removed from the design 
window’s title bar.

Shoving components
You can use the Shove command to automatically move 
previously placed components so that a component you 
have selected and are trying to place has enough room to 
be placed on the board. Layout Plus uses place outlines 
and insertion outlines to regulate this process. Insertion 
outlines can overlap each other, but place outlines cannot. 
The direction a component is shoved is determined by the 
degree of overlap between the component you are trying 
to place and the previously placed components.

To shove components

1 Choose the component toolbar button.

2 Select a component for placement. The component 
attaches to your pointer.

3 As you are positioning the component, choose Shove 
from the pop-up menu. Layout Plus moves other 
components away from the component being placed.
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Adjusting components
You can use the Adjust command to line up components, 
based on their connectivity.

Tip The components that you want to align should be in close proximity. 
This command is helpful for precise (not general) placement.

To adjust components

1 Choose the component toolbar button.

2 Press CTRL and select two components that you want 
to adjust.

3 From the pop-up menu, choose Adjust. Layout Plus 
aligns the components.

Placing components using clusters
Clusters are component groups formed to simplify 
placement. As with groups, clusters allow you to move 
multiple components at once, can represent specific 
circuits, and can be placed quickly in the appropriate area 
of the board. Compared to a number of individual 
components, clusters are simple from a graphic 
standpoint, which makes them ideal for quickly testing 
various placements, since your system can redraw 
clusters rapidly.

When reconnection mode is enabled, a circular border 
represents the combined area of all of the components 
within a cluster. Use the circle as a visual aid that indicates 
the amount of room needed to place the cluster in an area 
of the board.

Note When reconnection mode is 
enabled, a cluster is represented by a 
circle. When reconnection mode is 
disabled, the components are individually 
drawn; you need only click on one 
component to select them all.
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Tip If you cannot see a cluster’s circular border, your place outlines are 
either defined as invisible, or they are a color that is incompatible 
with the background color. To see a cluster’s border clearly, choose 
the color toolbar button. In the Color spreadsheet, select the row(s) 
for Place outline using the CTRL key and the left mouse button. 
Choose Visible<->Invisible from the pop-up menu (when an entity 
is set to visible, its spreadsheet color displays as a solid color, not as 
a diagonal pattern). If the color of the place outline (the cluster’s 
circular border) needs adjusting, assign a new color by 
double-clicking on the color cell for that row. A color palette 
displays. Select a color that will contrast well against the 
background color, then choose the OK button. Close the Color 
spreadsheet.

Figure 3 U3 and U8 are clusters.

To place components using clusters

1 Choose the component toolbar button.

2 From the pop-up menu, choose Select Any. The 
Component Selection Criteria dialog box displays.

3 Enter a group number in the Group Number text box 
and choose the OK button. You can create groups at 
the schematic level, or you can build them in Layout 
Plus.

Tip To group components in Layout Plus, 
choose the spreadsheet toolbar button, 
then choose Components. Select the 
components that you want to group by 
pressing CTRL and clicking the left mouse 
button. From the pop-up menu, choose 
Properties to display the Edit Component 
dialog box. Type an integer in the Group # 
text box and choose the OK button.
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4 From the pop-up menu, choose Make.

5 Position the cluster on the board and click the left 
mouse button to place it.

Breaking clusters
You can also use the Break command to dissolve a cluster 
into its individual components. Break unclusters the 
components, but does not change the location or 
parameters of any of the components within the cluster, 
nor does it separate the components from an assigned 
group.

To uncluster components

1 Choose the component toolbar button.

2 Select the cluster by pressing CTRL and clicking with 
the left mouse button.

3 From the pop-up menu, choose Break. The cluster is 
broken down into individual components.

Placing clustered components using Quick Place
After you place clusters on a board, Quick Place can 
unstack and arrange their components, separating them 
efficiently according to their place outlines.

To unpack and place clustered components using Quick Place

1 Choose the component toolbar button.

2 Select the cluster(s) by pressing CTRL and clicking with 
the left mouse button.

3 From the pop-up menu, choose Quick Place.

In Layout Plus, you create a place outline 
by creating an obstacle, and then defining 
it as a place outline. For information on 
doing this, see Creating obstacles in 
Chapter 5, Creating and editing obstacles 
in the OrCAD Layout User’s Guide.
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The individual components of the cluster(s) you selected 
are placed quickly, according to each component’s place 
outline.

Using circular placement
Circular placement may begin with or without selecting a 
component. You use the Circular Placement dialog box to 
set up circular placement.

If a component is selected, its current footprint name, 
group number, location (relative distance from circle 
center), rotation, radius, start angle from (0,0), and 
component angle are included in the dialog box when you 
open it. If you change the values for location, rotation, 
radius, or angle, it causes the component to be moved or 
rotated. Changing the reference designator does not affect 
the selected component.

During circular placement, the board datum temporarily 
shifts to the center of the proposed circle or arc. The values 
in the dialog are calculated relative to this temporary 
datum.

When you enter values for certain options in the dialog 
box, Layout Plus calculates the effect of the values on 
other parameters within the dialog box. For example, 
consider a board with its circle center at 0, 0. If you set the 
circle’s radius to 1000 mils and the Start Angle to 45 
degrees, the Rel Start automatically calculates to 707.100, 
707.100. These values display when you tab to another 
option in the dialog box, click in another field, or when 
you choose the OK button.

There is no error checking available to prevent component 
overlap. Angular values must be positive or negative 
values within the range of 0 to 360 degrees. Real numbers 
are supported, as are degrees and minutes. For example, 
an angle of 45.5 degrees is equivalent to 45 degrees 30 
minutes, and both values are supported.

Note You cannot select multiple 
components for circular placement. If you 
do select more than one component, 
Layout Plus chooses one from the selection 
to use for circular placement.

For more information on how option 
values affect other option values, see 
Auto-updating on page 26.



Using interactive placement commands

21

The following dialog box values are preset, based on a 
selected component:

n Footprint Name

n Group Number

n Circle Radius

n Start Angle

n Rel Start X, Y

n Comp Angle

If a component is not pre-selected, all dialog box values 
are persistent upon re-invocation of the dialog box, with 
the exception of Ref Des. If a component is preselected, the 
following dialog values are persistent upon re-invocation 
of the dialog box:

n Comp Count

n Angle To Fill

n Angle Between

n Comp Angle Increment

n Added Comp Angle

Note Blank fields are not legal.

To use circular placement

1 With no component selected, choose Circular 
Placement from the Auto menu. In the Circular 
Placement dialog box, choose the Footprint button, 
locate and select the footprint that you want to use for 
circular placement in the Select Footprint dialog box, 
then choose the OK button.
or
In the design window, select a component while 
pressing the CTRL key. From the Auto menu, choose 
Circular Placement. In the Circular Placement dialog 
box, the footprint name, group number, relative 
location to circle center, current rotation, current 
radius from circle center, current start angle from (0,0), 
and component angle are entered for you.

Tip In the Select Footprint dialog box, 
select Local in the Libraries window to 
select a part from your current board file.
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2 Enter new values as desired for the dialog box options. 
The options are automatically calculated and updated 
according to the inter-relationships of their values. See 
Auto-updating in this chapter for specific information.

3 Enter the number of components that you want to 
place in the Comp Count text box and select the Use 
Angle to Fill or Use Angle Between option. The Comp 
Angle Increment is automatically calculated, based on 
these entries.

4 Choose the OK button. The components are placed 
according to the values specified.

Note The Comp Count includes the 
selected component.

Note  Circular placement can be 
reversed using the Undo command only 
immediately after placement, but not 
following any subsequent commands.
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Figure 4 The Circular Placement dialog box

Footprint
Displays the Select Footprint dialog box, in 

which you can select a library and then a footprint for 
circular placement.

Reference Des
The reference designator for the selected component. 
Default shown is the next unused reference designator for 
the board. Or, you may enter your own unique reference 
designator.
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Group Number
Group number to associate with added components. The 
default is 0 (zero), meaning components do not belong to 
any group.

Circle Center X, Y
Coordinates of the circle center.

Circle Radius
Radius of the circle of placed components. The radius is 
measured from the circle center to the component 
placement point. The component is placed with its origin 
on this placement point.

Start Angle
Beginning placement angle of first component added or 
selected.

Rel Start X, Y
Placement location for first component added. This value 
is measured as a relative distance from the Circle Center 
value. If a component has been selected on the board, 
changing these values will cause the selected component 
to move and placement to begin from this new location.

Place Comp By
The drop-down list gives you choices of how the 
components are to be placed. Datum (the default) uses the 
board datum, Center uses the center of the component, 
Pin 1 uses pin 1 of the component, and Insert Pt uses the 
insertion point of the component. Regardless of how the 
component is placed, if it is subsequently rotated, it 
rotates about the datum.
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Comp Count
The total number of components to be added, inclusive of 
a selected component.

Use Angle to Fill
Toggle button to select between Angle to Fill and Angle 
Between.

Angle to Fill
The angle to be filled by added components.

Use Angle Between
Toggle button to select between Angle to Fill and Angle 
Between.

Angle Between
The space or angle between each added component’s 
placement point.

Comp Angle
The rotational angle of each added component. Changing 
this value will cause a selected component to rotate.

Comp Angle Increment
A successive rotation angle increment for each added 
component, calculated before placement. This will not 
affect a selected component; however, each added 
component will be rotated by this increment. For example, 
starting at 0, a Comp Angle Increment value of 20 degrees 
would cause components to be rotated before placement 
at 0, 20, 40, 60, and so on.
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Added Comp Angle
A rotational angle that is added to each component after it 
is placed. This command rotates the individual 
components in place, around their graphic origins. For 
example, starting at 0, if Comp Angle Increment is 20 and 
Added Comp Angle is 5, the component rotations would 
be 5, 25, 45, 65, and so on.

Auto-updating
Certain dialog box options are automatically updated to 
reflect how they are affected when other dialog box values 
are changed. The updated values display when the focus 
is changed in the dialog box using the TAB key, or by 
clicking the left mouse button on any other item in the 
dialog box. They are also updated when you choose the 
OK button to exit the dialog box. These relationships are 
listed below:

n Changing Circle Center X, Y automatically updates 
Circle Radius, Start Angle, Rel Start X, Y, and Comp 
Angle.

n Nothing automatically updates Circle Center X, Y.

n Changing Circle Radius automatically updates Rel 
Start X, Y.

n Changing Start Angle sets Comp Angle to the same 
value, and automatically updates Rel Start X, Y (by 
default, Start Angle and Comp Angle should be the 
same).

n Changing Rel Start X, Y automatically updates Circle 
Radius, Start Angle, and Comp Angle.

n Changing Comp Count automatically updates Angle 
to Fill, Angle Between, and Comp Angle Increment.

Note  By default, Start Angle and Comp 
Angle should be the same. However, you 
can change Comp Angle and it will not 
update any other option. 
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n Nothing automatically updates Comp Count.

n Changing Angle to Fill automatically updates Angle 
Between and Comp Angle Increment.

n Changing Angle Between sets Comp Angle Increment 
to the same value and automatically updates Angle to 
Fill.

Note By default, Angle Between and 
Comp Angle Increment should be the 
same. However, you can change Comp 
Angle Increment and it will not 
automatically update anything else.
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Index

A
Adjust command, 17
Adjust Comps pass, 10, 13
adjusting components, 17
algorithms, 3, 14
Assign Clusters pass, 10, 13
attempts, 14

B
Board command, 9
Break command, 19
breaking clusters, 19

C
circular placement, 20–21
Circular Placement command, 21
clusters, 2, 10, 13

breaking, 19
circles, 17
maximum, 14
placement, 2, 18
placing, 17

commands
Adjust, 17
Board, 9
Break, 19
Circular Placement, 21
EnableDisable, 9
Load, 7
Make, 18
Minimize Connections, 15
Place, 9
Quick Place, 19
Select Any, 18
Shove, 2, 6, 16
User Preferences, 15–16
VisibleInvisible, 18

components
adjusting, 10, 13, 17
autoplacing, 9
gate swapping, 14
groups, 18
insertion outlines, 16
pin swapping, 13
place outlines, 16, 18
proximity, 10, 13
shoving, 16
swapping, 10, 13
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E
editing place pass information, 11
EnableDisable command, 9

G
gate swapping, 14
ground nets, disabling, 9
groups, 2, 18

H
hiding routes and connections, 15

I
insertion outlines, 16
iterations, 14

L
Load command, 7

M
Make command, 18
maximum clusters, 14
Minimize Connections command, 15

N
nets, disabling power and ground, 9

O
outlines

insertion, 16
place, 16, 18

P
pin swapping, 13
Place Clusters pass, 10, 13
Place command, 9
place outlines, 16, 18

place pass
Adjust Comps, 10, 13
Assign Clusters, 10, 13
enabling, 12
information, editing, 11
Place Clusters, 10, 13
Proximity Place, 10, 13
Swap Comps, 10, 13
Swap Pins, 13

placement
algorithms, 3, 14
attempts, 14
clusters, 2, 17–18
fast reconnect, 14
groups, 2
iterations, 14
preparing the board, 5
push-and-shove, 2, 6
using autoplacement, 9
using circular placement, 20–21

placement strategy files, description, 7
power nets, disabling, 9
Proximity Place pass, 10, 13
push-and-shove placement, 2, 6

Q
Quick Place command, 19

R
reconnect mode, 15
round board, placing components on, 20–21

S
Select Any command, 18
Shove command, 2, 6, 16
shoving components, 16
strategy files

description, 7
loading, 7

Swap Comps pass, 10, 13
Swap Pins pass, 13
swapping

components, 10, 13
gates, 14
pins, 13



Index

31

U
User Preferences command, 15–16

V
visibility and color, 18
VisibleInvisible command, 18


